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 Data Storage and Memory

Take Off  (Page no. 11)

Double Tap (Page no. 13)

1.  Memory

2.  Permanent

3.  Pen Drive

	 Choose the correct option.

1. c. 	 2. a.	 3. c.	 4. d.

	 Fill in the blanks with the correct words.

1.  USB	 2.  Byte	 3.  Hard disk	 4.  Zettabyte
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A
Q 	 Answer the following questions:

1.	� The storage space in a computer is called memory.
2.	� Secondary memory is permanent in nature and is not directly accessed by the CPU. It allows 

users to store data that may be easily retrieved.
3.	� Hard disk is permanently fixed in the CPU Box. The most important function of the hard disk is 

to store program files and data files.
	� Pen drive is a portable storage device and is easy to use as it is small and can be carried in a 

pocket and plugged into any computer with a USB drive.
4.	� RAM is a temporary memory. The information stored in this memory is lost when the computer is 

turned off. That’s why it is also called volatile memory whereas ROM is the permanent memory, 
i.e. it holds the data even if the system is switched off. It holds the starting instructions that are 
required to start a computer. It is also called non-volatile memory.

	 Scratch Your Brain.

1.	

Hard Disk Compact Disk Pen Drive Memory Card

2.	 Competency-based/Application-based questions:
	 a.  Memory Card
	 b.  (iii)

 Managing Files and Folders in Windows 10

Take Off  (Page no. 18)
1.

This PC Folder

2.

Start Button

3.

Recycle Bin

4.

2.
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Double Tap (Page no. 22)

1.  b.	 2.  d.	 3.  a.	 4.  c.

	 Choose the correct option.

1.  d.	 2.  a.	 3.  b.	 4.  a.

	 Fill in the blanks with the correct words.

1.  Live	 2. This PC	 3. Two	 4. Thumbnail

	 �Tick ( ) the correct statements and cross ( ) the wrong ones.

1. 	 2. 	 3. 	 4. 

A
Q 	 Answer the following questions:

1.  �In the left pane it displays an alphabetical list of all the programs installed on your computer. In 
the right pane it contains tiles. 

2.  �A folder is like a file cabinet in which you can keep your files. In other words, a folder is a collection 
of files..

3.  Step 1: Open File Explorer and browse to the location where you want to create a new folder.
   Step 2: Click on the Home tab.
   Step 3: Click on the New folder option. 
   Step 4: Type the name of the New folder and press the Enter key. 
4.  �A file is a collection of data and information, stored on a storage device such as hard disk, pen 

drive, CD/ DVD.
   Step 1: Browse to the location of the file or folder you want to move.
   Step 2: Select the file or folder to be moved.
   Step 3: Click on Home tab.
   Step 4: Click on Cut command.
   Step 5: Select the destination location where you want to move the file or folder.
   Step 6: Click on Paste command.
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	 Scratch Your Brain.

1.	 a. Window key + E
	 b. Select file/ folder then press F2
	 c. Ctrl + C
	 d. Ctrl + V
2.	 Competency-based/Application-based questions:
	 a. Recycle Bin 
	 b. Start, Live

 More on Word 2019

Take Off  (Page no. 31)

Do it yourself

Double Tap (Page no. 38)

1. b.	 2. c.	 3. d.	 4. a.

	 Choose the correct option.

1. c.		 2. d.	 3. d.	 4. a.

	 Fill in the blanks with the correct words.

1. Columns	 2. Pictures	 3. Insert	 4. Merge Cells

	 �Tick ( ) the correct statements and cross ( ) the wrong ones.

1.  	 2. 	 3. 	 4. 	 5. 

3.
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A
Q 	 Answer the following questions:

1.  �The Shapes command is used to draw shapes, it has different categories of shapes, like Lines, 
Rectangles, Basic Shapes, Block Arrows, Flowchart, Stars and Banners, and Callouts.

2.  WordArt is a special effect in Word to change the appearance of the text.
3.  Step 1: Click on the Insert tab.
   Step 2: Click on the drop-down arrow and select Online Pictures option.
   Step 3: Type a word in Bing Image Search box.
   Step 4: Select the picture you want to insert.
   Step 5: Click on the Insert (1) button.
4.  Step 1: Select the rows or columns which you want to delete from the table.
   Step 2: Click on Layout tab.
   Step 3: Click on Delete drop-down arrow.
   Step 4: Select the desired option.

	 Scratch Your Brain.

1.	 a. Top Left alignment 
	 b. Top Center alignment 
	 c. Top Right alignment 
2.	 Competency-based/Application-based questions:
	 a. Step 1: Click on the Insert tab. 
	   Step 2: Click on the drop-down arrow and select This Device option. 
	   Step 3: Browse to the location of the screenshot 
	   Step 4: Select the screenshot 
	   Step 5: Click on Insert button 
	 b. Insert tab, Pictures command 

Periodic Assessment–1
(Based on chapters 1 to 3)

A.	 1. MEMORY	 2. FOLDER 	 3. FILE EXPLORER
	 4. RECYCLE BIN	 5. COMPACT DISK

B.	 1. Table 	 2. Delete a Table 	 3. Word File 	 4. RAM	 5. Folder
	 6. ROM	 7. Memory Card	 8. Music File

C.	 1. File	 2. Start Menu	 3. This PC	 4. Recycle Bin	 5. Taskbar
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 Introduction to PowerPoint 2019

Take Off  (Page no. 46)
Do it yourself.

Double Tap (Page no. 50)

1. Control Button
2. Text Placeholder
3. Speaker’s Notes Pane

Double Tap (Page no. 55)

1. F	 2. T	 3. T	 4. T

	 Choose the correct option.

1. a. 	 2. d.	 3. b. 	 4. d.

	 Fill in the blanks with the correct words.

1. Backstage	 2. Title bar	 3. Slide Show	 4. Slide area	 5. Insert

	 Match the following:

1. c. 	 2. e.	 3. d. 	 4. a.	 5. b.

	 �Tick ( ) the correct statements and cross ( ) the wrong ones.

1. 	 2. 	 3. 	 4. 	 5. 

A
Q 	 Answer the following questions:

1. � A presentation is made up of a series of slides. A single page of the presentation is called 
a slide.

2.  The Placeholder is a dotted box on a slide which may contain text, pictures, video, etc.

4.
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3. � A slide layout is the formatting and positioning of the placeholder boxes that appears on a slide. 
There are Nine slide layouts available in Power Point such as Title slide, Title and Content, Section 
Header, Two Content, Comparison, Title only, Blank, Content with Caption and Picture with Caption.

4.  Slide Sorter View 
   a.  It shows the miniature version of all slides.
   b.  �The advantage of this view is that you can see more number of slides on the screen and you 

can move, delete, edit and recognise these slides with greater ease.
   Reading View
   a.  �It is used when you want to view a presentation not in full screen but in a window with simple 

controls that make the presentation easy to review.
   b. The ribbon and the Slides/Outline pane are not visible.
5.  �Step 1: Click on the Insert tab.
   Step 2: Select SmartArt option.
   Step 3: Choose desired category.
   Step 4: Choose a graphic layout.
   Step 5: Click on the OK button.
   Step 6: Click on [Text] in each individual shape and type the desired text.

	 Scratch Your Brain.

1.	 a. SLIDE	 b. PRESENTATION	 c. BACKSTAGE
	 d. PLACEHOLDER	 e. SMARTART
2.	 Competency-based/Application-based questions:
	 a. SmartArt
	 b. Abhilaksh can insert SmartArt.

 Using a Browser

Take Off  (Page no. 62)

1.  Search information	 	 5.  Send and receive e-mail 	

2.  Chat online 	 	 6.  Take a bath	

3.  Sleep	 	 7.  Watch a cartoon movie	

4.  Buy a mobile phone	 	 8.  Pack your bag	

5.
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Double Tap (Page no. 64)

1.  Refresh	 2. New Tab	 3. Microsoft Edge	 4. Favorites

	 Choose the correct option.

1.  b.	 2.  d.	 3.  c.	 4.  d.

	 Fill in the blanks with the correct words.

1.  Internet	 2.  Microsoft Edge	 3.  Home page	 4. Refresh

	 �Tick ( ) the correct statements and cross ( ) the wrong ones.

1.  	 2. 	 3. 	 4. 

A
Q 	 Answer the following questions:

1.  �Search engine is a web tool which allows user to search or look up for desired information of 
the Internet.

2.  �Downloading is the process of transferring data from a server (the Internet) to a client computer 
(the user’s computer), whereas Uploading is the process of moving data from your computer (the 
computer of the user) to a server through the internet. 

3.  �Microsoft Edge is the default web browser in the Windows 10 operating system. Current Tab, 
Address Bar, New Tab.

	 Scratch Your Brain.

1.	 Do it yourself.
2.	 Competency-based/Application-based questions:
	 a. Voice search
	 b. Address bar 
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Periodic Assessment–2
(Based on chapters 4 & 5)

A.	 1. Slide Layout 
	 2. Speaker’s notes pane 
	 3. Reading view 
	 4. Backstage
B.	 [This labeling was printed incorrectly, please correct it in your textbooks.]

Tabs Title bar Control buttonsQuick Access Toolbar

Ribbon

Slides/Outline 
pane

Status bar Speaker’s Notes pane Placeholder

C.	 1. 	 2. 	 3. 	 4. 

Test Sheet–1
(Based on chapters 1 to 5)

A.	 1. c.	 2. b.	 3. b.	 4. b.	 5. c.	 6. a.
	 7. d.	 8. c.	 9. c.	 10. a.	 11. b.	 12. d.

B.	 1.  Columns	 2.  Status bar	 3.  Down	 4.  Pictures	 5.  Slide area	 6.  Refresh

B.	 1. 	 2. 	 3. 	 4. 

D.	 1.  d.	 2.  c.	 3.  a.	 4.  b.
E.	 1. A collection of related files is called a folder.
	 2. The intersection of a row and a column called Cell.
	 3. �A presentation is made up of a series of slides. A single page of the presentation is called a 

slide.
	 4. Placeholder is a dotted box on a slide which may contain text, pictures, video, etc.
	 5. WordArt is a special effect in Word to change the appearance of the text.
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	 6. The steps to change the row height in a table are:
	   a. Select the rows or columns.
	   b. Click on Layout tab.
	   c. Change the height and width of cells from the Height and Width Scroll box. 
	 7. �The basic unit for measuring the memory of a computer is byte. A byte consists of a group of 

eight bits, for example, 10001011, i.e. 1 byte equals to 8 bits. A group of 4 bits is known as a 
nibble (half byte), for example, 1001, i.e. 1 nibble equals to 4 bits.

	 8. �Slide layout is the formatting and positioning of the placeholder boxes for the content 
that appears on a slide. Their are Nine Slide layout Title Slide,Title and Content, Section 
Header, Two Content, Comparison,Title Only, Blank,Content with Caption, and Picture 
with Caption.

 Visual Processing

Take Off  (Page no. 76)

1 2 3

4 5

a

b c d

e

1.

4. 5.

2. 3.d. c. b.

a.e.

6.
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Double Tap (Page no. 79)

Cat

TreeCloud

A1

A2B3

MoonA3

3

2

1

A B C

	 Choose the correct option.

1. d.	 2. a.	 3. a.

A
Q 	 Answer the following questions:

1.  �Picture Puzzle is a type of visual activity that involve a series of pictures that are interpreted.
2.  �When a shape looks exactly the same to its original shape after being flipped or turned, it is 

called a mirror image.

	 Scratch Your Brain.

1.  Do it yourself
2.  
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 More Blocks in Scratch

Take Off  (Page no. 83)

Double Tap (Page no. 85)

5

3

4

1

2

	 Choose the correct option.

1. a.	 2. d.	 3. a.	 4. a.

	 Fill in the blanks with the correct words.

1. �Say	 2. Go to	 3. Sound	 4. Move

7.
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	 �Tick ( ) the correct statements and cross ( ) the wrong ones.

1. 	 2. 	 3. 	 4. 

A
Q 	 Answer the following questions:

1.	� a.  Stage area
	 b.  Backdrop
2.	 The blocks that are used to control the movement of a sprite are know as Motion blocks.
3.	� The blocks that are used to control how the blocks in a script will start to run if a particular action 

is done are known as Events blocks.
4.	 [This question was printed incorrectly in the book. Please correct it in your textbook]
	 Question: How can you determine the sprite’s position?
 	  Ans. �The sprite’s position is determined when the stage is divided into different values of x and y. 

Each dot on the stage is made up of both x and y values. The value of x gives the horizontal 
(left to right) location of the sprite. The value of y gives the vertical (top-to-bottom) location 
of the sprite.

	 Scratch Your Brain.

1.	 M

O

T

I

O

N

C

X

C

V

S

E

A

O

S

R

P

B

B

O

N

E

V

E

N

T

S

T

N

O

N

P

O

M

R

S XG

P OA

Z RT

X KO

R WR

U LC

O QL

I MO

E RT

U TI

T SO

O RA

F CP

L MP

N O

R S

R O

L U

W N

L D

G Z

2.	 Competency-based/Application-based questions:
	 a. Sound Blocks 
	 b. Add sound blocks
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 Creating Shapes in Scratch

Take Off  (Page no. 92)

1. Sprite 	 2. Stop button	 3. Backdrop 

Double Tap (Page no. 94)

1. Heptagon	 2. Triangle 	 3. Pentagon 	 4. Nonagon
5. Hexagon	 6. Octagon

	 Choose the correct option.

1.  b. 	 2.  c.
[This question was printed incorrectly in the book. Please correct it in your textbook]
3.  Question: Which block is a part of the pen blocks category?

	 a.  go to x: y:-100 -34 	 b.  say for secondsHello! 2

	 c.  pen up 	 d.  when space key pressed

  Ans. �c.

	 Fill in the blanks with the correct words.

1. Polygon	 2. 360	 3. Go	 4. Hexagon

A
Q 	 Answer the following questions:

1.	� Pen block is used to draw a trail as the sprite moves on the stage .You can change the colour 
of the pen.

2.	 Polygons are 2D shapes with three or more straight lines and angles.

3.	

8.
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	 Scratch Your Brain.

1.	 a. Sides	 3
	   Degree	 120
	 b. Sides	 4
	   Degree	 90
	 c. Sides	 5
	   Degree	 72
	 d. Sides 	 6
	   Degree	 60
2.	 Competency-based/Application-based questions:
	 a. She can use Stamp Block 
	 b. Repeat 9 Move 100 steps Turn 40 degrees

Periodic Assessment–3
(Based on chapters 6 to 8)

A.	 Do it yourself
B.	

B2

Bush Apple

B3

Dustbin

A2

C.	 a. This block will set the pen colour, saturation, brightness and transparency to the given value.
	 b. �This block creates a duplicate of the current sprite. To see the image, click on the sprite and 

drag.
	 c. This block changes the pen colour, saturation, brightness and transparency.

 Google Blockly Games

Take Off  (Page no. 100)
1.	 Move the object in the forward direction from the direction it is facing. 
2.	 Turn the object in the left direction from the direction it is facing.

9.
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Double Tap (Page no. 100)

1. 	 2.         3. Bird game

	 Choose the correct option.

1.  b.	 2.  c.	 3.  b.	 4.  b.

	 Fill in the blanks with the correct words.

1.  Turtle	 2.  Loops	 3.  Turn…by	 4.  Run Program

	 �Tick ( ) the correct statements and cross ( ) the wrong ones.

1.	 	 2. 	 3. 	 4. 

A
Q 	 Answer the following questions:

1.	 Heading Block 
	 If do else Block
2.	� If the bird does not reach to the desalination then run program button will change in to Reset 

button and to do it again click on the reset button.
3.	�

	 Step 1: Drag the following blocks and change required value to draw a square.
	 Step 2: Click on Run Program button.

	 Scratch Your Brain.

1.	 a.  This block turns the object in the left direction from the direction it is facing.
	 b.  �This block allows the bird to fly in one direction till the condition is true, and it changes 

direction when the condition becomes false.
2.	 Competency-based/Application-based questions:
	 a.  (ii)
	 b.  Turtle Game
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	 Evolution of AI

Take Off  (Page no. 108)

1.  Smartphone 	 2.  Smartwatch 	 3.  Smart Speaker 

Double Tap (Page no. 111)

1.	 WABOT	 2.  ASIMO

	 Choose the correct option.

1.  a.	 2.  b.	 3.  d.	 4.  a.

	 �Tick ( ) the correct statements and cross ( ) the wrong ones.

1.  	 2. 	 3. 	 4. 

A
Q 	 Answer the following questions:

1.	 Artificial Intelligence is the ability of a machine to think and learn.
2.	� In 1950, Alan Turing submitted a paper about the possibility of creating machine that would 

think. This became a test for machines to check their thinking capability. One of the greatest 
achievements of Alan Turing is the creation of Bombe, a machine that could decode encoded 
messages.

3.	� Roomba, an autonomous robot vacuum cleaner that cleans and is able to avoid crashing into 
obstacles.

4.	� In 2016, David Hanson created a humanoid named Sophia. She can copy human gestures and 
facial expressions.

	 Scratch Your Brain.

1.	 a. ALAN TURING	 b. WABOT	 c. ROOMBA
	 d. SOPHIA 	 e. CORTANA
2.	 Competency-based/Application-based questions:
	 a. (iii)
	 b. Google home 

10.
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Periodic Assessment–4
(Based on chapters 9 & 10)

A.	 1. �This block turns the object in the left direction from the direction it is facing.
	 2. �This block allows the bird to fly in one direction till the condition is true, and it changes direction 

when the condition becomes false.
	 3. �The condition allows the bird to move in the direction in do section of the block till the 

condition is true otherwise move in the direction in the else section of the block when the 
condition becomes false.

	 4. �The move…by block is used to make the turtle move the forward or backward to draw the 
shape.

	 5. �The repeat…times do block to make the turtle repeat tasks given inside the block for given 
number of times.

B.	 1. iii.	 2. i.	 3. v.	 4. ii.	 5. iv.

Test Sheet–2
(Based on chapters 6 to 10)

A.	 1. d.	 2. d.	 3. a.	 4. a.	 5. c.
	 6. b.	 7. b.	 8. a.	 9. a.	 10. a.
	 11. b.	 12. b.
B.	 1. John McCarthy	 2. Polygon 	 3. 360	 4. Go to 	 5. Bombe
C.	 Tick ( ) the correct statements and cross ( ) the wrong ones.
	 1. [This question was printed incorrectly in the book. Please correct it in your textbook]
	   Question: �Picture Puzzle is a type of visual activity that involve a series of pictures that are 

interpreted.
	   Ans. �
	 2. 
	 3. [This question was printed incorrectly in the book. Please correct it in your textbook]
	   Question: �Kismet was developed in year 2000.
	   Ans. �
	 4. 
D.	 1. c.	 2. a.	 3. d.	 4. b.
E.	 1. Artificial Intelligence is the ability of a machine to think and learn.
	 2. �In 1950, Alan Turing submitted a paper about the possibility of creating machine that would 

think. This became a test for machines to check their thinking capability. One of the greatest 
achievements of Alan Turing is the creation of Bombe, a machine that could decode encoded 
messages.

	 3. Visual Processing  
	 4. Control Block  
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	 5. �Pen block is used to draw a trail as the sprite moves on the stage .You can change the colour 
of the pen.

	 6. �To draw a square we can keep the value of the move block same but to draw a rectangle there 
will be 2 different values for the move block since there are two different values for sides of 
rectangle i.e., length and breadth.

	 7. �When a shape looks exactly the same to its original shape after being flipped or turned, it is 
called a mirror image. 

	 8. �If the bird does not reach to the desalination then run program button will change in to Reset 
button and to do it again click on the reset button.




